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1. INTRODUCTION 
The CRITERION ™ Analysis application provides a complete set of tools for statistical analysis of data in the 
CRITERION historical database. These analysis tools may be defined so that data from a specific time range is 
displayed or defined to automatically update so that processes are monitored in real time. 
 
1.1 APPLICATION OVERVIEW 
 
The diagram below illustrates the components of the main application window. A variables control chart is 
displayed as an example.  Note that the New, Open, Save, and Print buttons perform the same functions as the 
corresponding items in the File menu.   Use the Help button to access the online help file for the Analysis 
application.  
 

 
 
1.2 MENUS 
 
1.2.1 The File Menu 
 
New... - This is used to initiate the chart selection and data selection processes used to create a new document. 
 
Open... - This option calls the Open window, from which a previously saved CRITERION chart may be opened. 
 
Close - This option closes the currently active analysis document. You will be prompted to save changes. 
 
Save - This is used to save the currently active document in a file. If the document has been previously saved 
changes will be saved to that file. 
 
Save As... - This is used to specify a directory path and filename to which the currently active document is saved. 
 
Save All - This is used to save all currently open documents as described above under the "Save" item. 
 
Export - This menu item is used to export the data that was used to build the currently active chart. 
 
New Workspace - This menu item is used to initiate the chart selection and data selection processes that are 
used to create a new analysis document. 
 
Open Workspace - This menu item allows the user to open a previously saved workspace file. 
 
Close Workspace - Choosing this item closes the currently active workspace (and all the documents within). 
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Save Workspace - This is used to save the currently active document in a file. If the document has been 
previously saved, changes will be saved to that file. If the workspace has not yet been saved, this menu option 
invokes a Save As… window, with which you can specify a name and location for the workspace file. 
 
Print Setup... - This menu item calls the Print window, which is used to specify a printer and printer options. 
 
Print... - This item calls a window that allows you to preview and the print the active analysis document. 
 
Preferences... - This item allows you to specify default options for analysis documents. 
 
Exit - This menu item closes the CRITERION Analysis application. 
 
1.2.2 The Edit Menu 
 
Copy - Choosing this menu option places a copy of the selected graphic in the clipboard. 
 
Exclude Multiple Points - This enables multiple data points to be masked or excluded by dragging the mouse 
across the control chart or clicking on the data points. The right mouse button is used to complete the selection. 
 
Include Multiple Points - This enables multiple data points to be included by dragging the mouse across the 
control chart or clicking on the data points. The right mouse button is used to complete the selection of points. 
 
1.2.3 The Chart/Report Menu 
 
Change Chart Type - Replaces the existing analysis window with a new analysis document using the same data.  
 
Clone Data Selection - Creates a new analysis document in a separate window with the same data selection. 
 
Select Data… - When an analysis document is open, this item calls the Data Selection window. The current data 
selection may be then changed by selecting a different date and time range or by selecting different filters. 
 
Options... - When an analysis document is open, this item calls a window from which the options for the active 
document may be changed. 
 
1.2.4 The View Menu 
 
Undo Zoom - Returns the selected chart from zoom mode. 
 
Toolbar - Selecting this option toggles the display of the toolbar. If there is no checkmark next to this option, the 
toolbar will be hidden. If there is a checkmark next to this option, the toolbar is made visible. 
 
1.2.5 The User Menu 
 
Log User 
 
Selecting this option will log the current user out of the application, allowing another user to login. 
  
1.2.6 The Window Menu 
 
Cascade - This menu option will cause all open windows to be resized and moved such that all title bars are 
visible. The first (active) window is placed in the upper left-hand corner of the application window.  Each 
subsequent window is placed slightly lower and to right of the previous one, so that each window is visible, and 
each may be selected by clicking on the title bar. 
 
Tile Horizontally – All open windows are sized approximately equally and arranged to use all vertical space. 
 
Tile Vertically - All open windows are sized approximately equally and arranged to use all horizontal space. 
 
Arrange Icons - When Arrange Icons is selected, icons, representing minimized windows of the Analysis 
application, are arranged to form straight rows across the bottom of the Analysis window. 
 
<Open Window #1> - <Open Window #n> - The last items listed in the Window menu correspond to the open 
document windows. If no analysis documents are open, these items are not displayed. If there are analysis 
documents open, selecting a document from the list makes that document window active. 
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1.2.7 The Help Menu 
 
Contents - This causes the Contents window of the CRITERION Analysis help application to be displayed. 
 
Search for Help on... – This calls the CRITERION Analysis help application with the Search window displayed. 
 
About Analysis... - This displays a window with version and copyright information and system specifics. 
 

2. BASIC FUNCTIONALITY OF CRITERION ANALYSIS 
 
2.1 LOGGING IN AND LOGGING OUT 
 
If you are not already logged in, you must login to gain access to the Analysis application. By logging-in, you 
identify yourself so that the program can grant the correct user privileges.  
 

 
 
To login 
You will be required to login when you launch the Analysis application, or after another user logs out.  To login, 
you must know the User Name and Password that is assigned to you. 
 
1. Enter your User Name by typing your user name or selecting your name from the list of users 
 
2. Press ENTER or click in the password field. 
 
3. Type your assigned password in the box in the bottom of the window. Any combination of capital and lower-
case letters are accepted. As you type, stars (*) display instead of letters. 
 
4. Click OK or press ENTER. 
 
5. If you enter your password incorrectly, a message warns you. You must re-enter the password only. 
 
To log out of the Analysis application 
Logging out halts the application until a user with access to the application logs in. To log out without exiting the 
application, press F2 or click Log User in the User menu. To log out and exit, select Exit from the File menu. 
 
2.2 CREATING A NEW ANALYSIS DOCUMENT 
 
In general, all types of analysis documents are created by following the same steps. Creating an analysis 
document consists of selecting an analysis type and selecting data to be analyzed. This section describes in 
detail the procedures to follow for creation of a new analysis document. 
 
To Create a New CRITERION Analysis document: 
1. Select New from the File menu. 
 
2. Select the type of analysis document (chart) to create. 
 
3. Select the data to be used in analysis (see below). 
 
2.3 SELECTING DATA FOR ANALYSIS 
 
To create a new analysis document, you must specify which data to include in the analysis. Selection by 
organizational level is required, and involves the choice of one or more characteristics or processes. 
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Chronological selection involves the specification of a date/time range. As an option, data may also be selected 
by applying a filter based on operation, user name, warning code, and data tag criteria. All such types of data 
selection are described in the sections below. 
 
2.3.1 Selecting Data by Organizational Level 
 
Selection by organizational level is the first step in selecting data for analysis. This simply involves selecting one 
or more characteristics or processes that contain the data to be analyzed.  
 
Some types of analysis are meaningful only when data with similar properties (like data from a single machine) 
are included. Other charts provide summary analysis for different sets of unrelated data.  Since data is organized 
into hierarchies, the scope of analysis is often defined by selection of organizational level.  
 
To Select Data by Organizational Level 
1. Display the product tree or process tree by selecting the appropriate button on the left side of the window. 
 
2. From the tree, select the characteristic(s) to be used for the chart by highlighting the appropriate item and 
clicking the Add button. For charts that analyze only one characteristic, the selection of multiple characteristics will 
produce more than one chart. 
 
3. Click the OK button and proceed with other data selection. 
 
2.3.2 Other Data Selection 
 
After selecting data by organizational level, the Data Selection window appears. From here, the user may perform 
chronological selection and filter by operation, user names, warning code, and subgroup tags. 
 
To select data chronologically, do one of the following: 
 
To  
 
Include the most recent subgroups 
 
 
 
Include data from recent hours, weeks, days, months, or 
quarters 
 
 
Include data since the last corrective action was recorded 
 
 
Include data in a specific time and date range 
 

Do this 
 
Select the first option.  Specify the number of subgroups in 
the middle box. Select Subgroups from the list in the right 
box. 
 
Select the first option.  Specify a number in the middle 
box. Select a time period (e.g. Hours) from the list in the 
right box. 
 
Click the Since Last Corrective Action option. 
 
 
Click the Data in Time/Date Range option. Select starting 
and ending time and dates.

 
 
To filter data by other selection criteria, do one or more of the following: (These selections are optional) 
 
To  
 
Include only data from specific operation(s)* 
 
 
Include only data collected by certain user(s) 
 
 
Include only data that generated specific warning codes 
 
 
Include only data with specific subgroup tag values 
 
 
Remove all filter criteria  

Do this 
 
Click Operation in the left pane. Select one or more 
operations from the right pane. 
 
Click User in the left pane.  Select one or more users from 
the right pane. 
 
Click warning in the left pane. Select one or more warning 
criteria in the right pane. 
 
Click on an appropriate tag name in the left pane and 
select tag values in the right pane. 
 
Click the Deselect Tags button
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2.4 CUSTOMIZING AN ANALYSIS DOCUMENT 
 
Upon creation, new analysis documents assume the view and calculation options that have been specified as 
defaults in the Preferences window. Even after a document is created, however, it may be further customized by 
changing its view or calculation options. To change the options for the currently active document window, select 
Options… from the Chart menu.  
 
2.5 FORMATTING AND PRINTING A DOCUMENT 
 
Several options are available for formatting an analysis document prior to printing. As described below, the Print 
dialog allows the user to specify the size, page orientation, and various printer options for the document. 
 
To format and print an analysis document 
1. Select Print… from the File menu. When the Print window appears, the chart is displayed as it would appear on 
paper. To change the default printer, click the Setup… button and select a printer from the list of printers. 
 
2. Note that depending on which version of Windows you are running, other print options may be available from 
this window. After selecting a printer and setting other options, click the OK button to continue. 
 
3. Format the document by clicking the Page Setup button and setting the options as described below. 
 
To:  
 
Change the position of the print object on the page 
 
Change the size of the print object on the page 
 
 
Print the graphical part of the chart 
 
 
Print annotations and statistics with the chart 
 
 
Print the raw data along with the chart document 
 
Print the chart graphic on a separate page from the chart 
information and data 

Do this: 
 
Select vertical and/or horizontal alignment options. 
 
Specify scaling percentages for the chart in the fields 
labeled Vertical Size and Horizontal Size. 
 
Ensure that the Print Chart item in the Printing Options 
frame is selected. 
 
In the Printing Options frame, select the Print Chart 
Information item. 
 
In the Printing Options frame, select the Print Data item. 
 
In the Printing Options frame, select the On separate page 
item.

 
4. After dismissing the Page Setup window, the Print window will display a preview of the document as it will be 
printed. To print the document as it is shown in the preview, click the Print button. 
 
2.6 USING ANALYSIS DOCUMENT FILES 
 
Analysis documents may be saved as files for future reference.  When a document is saved as a file, it includes 
everything necessary to re-create the document, except the actual data.  All options, data selection criteria, and 
the size and location of the document window are saved in the file. The actual data used to create the chart are 
stored in the database. Thus, the database used to create a saved chart file must be available when the chart file 
is re-opened. 
 
Tip: If you frequently refer to a particular chart to monitor a process, you can save that chart so that simply re-
opening that chart re-creates the chart using the most recent data. For example, if you usually monitor a 
characteristic by plotting a control chart of the last 50 subgroups, you need only create, customize, and save the 
chart as a file once. Each time you re-open the document, the most current 50 subgroups in the database for that 
characteristic are automatically charted. 
 
2.6.1 Saving an Active Analysis Document 
 
To save the currently active analysis document 
1. Select Save or Save As from the File menu. 
 
2. If prompted in the save-as window, specify the filename, directory, and drive where the file will be stored. 
 
3. Click the OK button to save the file or the Cancel button to dismiss window without saving the file. 
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When you save changes to a document file that was saved previously, the Analysis application does not request 
a new filename, but it does make a backup copy of the document file as it was before changes. Thus, if you need 
to return the document as it was, you can do so by renaming the backup with a .vcd extension. Note that in 
Preferences (Defining General Analysis Preferences) you may disable the creation of backup files. 
 
2.6.2 Closing an Open Document 
 
An open document may be closed by choosing Close from the File menu or by clicking the close box in the upper 
right corner of the document window. If the document is new (has not been saved) or if changes were made to the 
document since the last save operation, you will be given the option to save the document before closing it. 
 
2.6.3 Opening a Document File 
 
Once an analysis document has been saved as an Analysis file, it may be re-opened. Any document with the .vcd 
file extension that was saved using the CRITERION Analysis application may be re-opened, as long as the user 
has access to the database from which the document was originally created. 
 
To open an existing document file 
1. Select Open from the File menu. 
 
2. Select a file to be opened. If necessary, first select the drive and directory (path) where the file is located. 
 
3. Click the OK button to open the selected analysis document or the Cancel button to dismiss the window without 
opening the document. 
 
2.7 USING ANALYSIS WORKSPACES 
 
Often it is important to combine SPC tools for statistical analysis. For example, you might monitor a process by 
analyzing a variables control chart and a histogram together. Alternatively, you might view multiple control charts 
side-by-side to monitor related processes. To facilitate analysis of this type, the Analysis application employs the 
use of workspaces. A workspace is a collection of several analysis documents arranged in a particular manner 
within the application window. Like analysis documents, workspaces can be saved as files. When a workspace is 
saved, the relative positions of all open documents are also saved. When the workspace is re-opened later, all of 
the associated documents are opened and positioned on the screen exactly as they were when it was saved. 
 
2.7.1 Creating a New Analysis Workspace 
 
Workspaces consist of one or more analysis documents positioned in the Analysis application window. In order to 
save a workspace, it must be created. A new workspace can be created before or after creating the analysis 
documents that belong to it.  
 
To create a new analysis workspace 
1. Choose New Workspace from the File menu. 
 
2. Open or create analysis documents and arrange them as desired. Be sure to save the workspace after all 
documents are properly arranged. 
 
2.7.2 Saving an Open Workspace 
 
After a workspace is created, it may be saved.  When the workspace is saved, all documents in the workspace 
are saved as chart files, and the relative position of each document window is saved. Note that the data selection 
criteria and options for each document are saved to the corresponding chart file instead of the workspace file.  
 
To save an analysis workspace 
1. Format the workspace by sizing and positioning the document windows as desired. 
 
2. Select Save Workspace from the File menu. 
 
3. If prompted, specify where the file will be stored. Workspace files are saved with a “.wsp” file extension. 
 
4. If the workspace includes any documents that have not been saved since they were last changed, the 
application will prompt the user to save each one individually. 
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5. Click the OK button to save the file or click the Cancel button to dismiss window without saving the file. 
 
When you save changes to a workspace file that was saved previously, a new filename is not requested, but the 
Analysis application makes a back-up copy of the workspace file before changes.  Thus, if you need to return the 
workspace as it was before changes, rename the backup with a .wsp extension. Note that by changing the 
Preferences (Defining General Analysis Preferences), you may disable the creation of backup workspace files. 
 
2.7.3 Closing an Open Workspace  
 
The open workspace may be closed by choosing Close Workspace from the File menu. If the workspace has not 
been saved or includes unsaved changes, the application will give the option to save before closing. Likewise, 
you will be prompted to save any documents that have changed since they were last saved. 
 
2.7.4 Opening a Workspace  
 
 Once a workspace has been saved, it may be re-opened by following the instructions listed below. 
 
To open an existing workspace file 
1. Select Open Workspace from the File menu. 
 
2. Select a workspace file to be opened. If necessary, first select the drive and directory (path) where the file is 
located. 
 
3. Click the OK button to open the selected analysis document or the Cancel button to dismiss the window without 
opening the document. 
 
2.8 USING DATA SELECTION FOR MORE THAN ONE CHART 
 
After creating a variables control chart, you may wish to create a histogram of the same data selection to examine 
process distribution. The Analysis application provides a quick way to create a new analysis type using the same 
data selection. The new chart may replace the original chart window or it may be created in a new window so that 
the different analysis tools may be viewed simultaneously. 
 
To create a new chart in place of the original 
1. Select the original chart. 
 
2. Select Change Chart Type from the Chart/Report menu. 
 
3. Choose an analysis type by clicking the picture button for the chart type. 
 
To create a new chart in addition to the original 
1. Select the original chart. 
 
2. Choose Clone Data Selection from the Chart/Report menu. 
 
3. Select an analysis type by clicking the picture button for the chart type. 
 
2.9 COPYING DOCUMENTS TO OTHER APPLICATIONS 
 
Most Windows applications allow pictures and text to be pasted into files. The Analysis application allows you to 
copy and paste all or part of an analysis document into other Windows applications. Charts, annotations, 
statistics, or the whole document may be copied and pasted.  
 
To copy all or part of an analysis document 
1. Click on the object that you wish to copy. If you click on just the chart or the text, you will see a black outline 
appear around the object to indicate what is selected. Copying only the chart or the text will provide the best 
quality in the target application, especially if the chart is to be resized or the text reformatted. If you click on the 
boundary between the chart and the text, you will select the entire document as a bitmap image. When pasted in 
to the target application, this can produce a jagged image, especially after resizing. 
 
2. Select Copy from the Edit menu or press CTRL+C. 
 
3. Paste the chart, text, or image into the target application. 
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2.10 EXPORTING DATA FROM A CHART 
 
It is possible to quickly export the charted data into a text file that is readable by most types of spreadsheet or 
column-oriented analysis tools. This is useful when using ad-hoc analysis functions like those included in JMP or 
Excel. The format of such an exported file varies, depending on the type of chart that was used to create it. This is 
because files exported from a chart only include the information necessary to build the chart itself. Consult the 
section specific to the chart type for information about the format of the exported file.  
 
To export the charted data into a text file 
1. Open or create a chart document. 
 
2. Select Export... from the File menu. 
 
3. Specify a target directory and name for the export file.  Click OK 
 
2.11 ARRANGING DOCUMENT WINDOWS 
 
Cascade - All open windows are sized equally and the windows are cascaded diagonally across the Analysis 
window starting from the upper left. The title of each window is visible so that any window can easily be selected 
by clicking on its title.  
 
Tile Horizontally or Tile Vertically - When selected, open windows are sized approximately equally and 
arranged to use all available space. 
 
Arrange Icons - When selected, icons, representing minimized windows of the Analysis application, are arranged 
to form straight rows across the bottom of the Analysis window. 
 
2.12 WORKING WITH THE HELP SYSTEM 
 
To browse the contents of the help system 
1. Choose Contents from the Help menu. This launches the Windows help application for Analysis. 
 
2. Select one of the categories by clicking on the corresponding icon. 
 
3. Once the desired help topic has been viewed, exit the application by choosing Exit from the File menu. 
 
To use the help search engine 
1. Choose Search for Help on… from the Help menu. This launches the Windows help application for Analysis, 
and displays the Search window. 
 
2. The Search window lists all available topics in the Analysis application. To find a specific topic, type in the text 
box. The list below will update automatically to show the help topics that most closely match the search string. 
 
3. From the topics listed, select one to move directly to that help topic. Once the desired help topic has been 
viewed, the user must exit from the Windows help application by choosing Exit from the File menu. (Note: users 
may access the index from within the Contents window described earlier). 
 
2.13 EXITING THE APPLICATION 
 
To close the Analysis application, choose Exit from the File menu, then click YES.  If any analysis documents are 
open when this command is issued, they will be closed before the application is terminated. 
 
3. CHARTS AND REPORTS 
 
Various charts and reports are used to monitor process output in an effort to maintain a state of statistical control. 
The following sections provide information about specific charts and reports. 
 
 
3.1 VARIABLES CONTROL CHARTS 
 
Variables control charts are actually composed of two charts, and thus have two sets of control limits.  One is 
used to help detect shifts in process mean, while the other is used to detect changes in process variance. By 
convention, the mean chart is placed directly above the variance chart. Both plot statistics for subgroups of data 
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over time and share a common x-axis.  Generally speaking, a variables process is considered to be "in control" 
when estimated subgroup means and variances fall within their respective control limits. To increase the control 
chart's sensitivity to changes in the process, CRITERION also uses numerous warning criteria that are designed 
to observe trends in the data that may indicate out-of-control situations in advance. Such warnings are defined 
using the Admin application, and are checked by the Acquire application during the data collection process.  
 
3.1.1 Creating Variables Control Charts 
 
When the user requests a variables control chart, Analysis looks up special information regarding the selected 
characteristic(s) from the database. In particular, each variables characteristic has a specific type of control chart 
associated with it. This information is entered in the Admin application and ensures that the control chart is 
appropriate for the selected data. To create a variables control chart, follow the steps listed below. 
 
To create a variables control chart 
1. Select New from the File menu. 
2. In the Chart Selection window, select Variables Chart. 
3. Display the product tree by selecting the option button labeled Product on the left side of the window. 
4. Select the characteristic to be used in the chart by highlighting the appropriate item and clicking the Add button. 
5. Click the OK button and proceed with data selection. 
 
3.1.2 Customizing Variables Control Charts 
 
A variables control chart in the Analysis application is customized by changing options for the document. New 
analysis documents assume the options that were previously defined as defaults in Preferences. Once created, 
however, the document options can be changed without affecting default preferences. If the document is saved as 
a file, the customized options are saved in the file and applied whenever the document is re-opened. 
 
To set options for the active variables control chart document 
1. Select Options… from the Chart/Report menu to call the Variable Control Chart Options window. 
 
2. Select the View tab and set the options as desired. Individual options on the View tab are described in the 
following table. 
 
To:  
 
Display the starting and ending time & date for the data 
range 
 
Display data tag values for the data selection 
 
Display the chart type ( X-Bar & R, etc.) 
 
Display the branches of the product or process trees that 
contain the data 
 
Display the number of subgroups in the chart (both 
included and excluded) 
 
Display the specification limits as Numbers  
 
Display the mean chart’s centerline as a number 
 
Display a header or footer 
 
Automatically update the chart periodically 
 
 
 
Disable auto updating of the chart 
 

Do this: 
 
Check Start/End Date. 
 
 
Check Data Tags. 
 
Check Chart Type. 
 
Check Process Group, Process, Class, Family, Product 
Group, Product, or Characteristic. 
 
Check subgroup count 
 
 
Check USL/LSL 
 
Check Average/Mean 
 
Enter text in the Header Text or Footer Text boxes. 
 
Select the first option in the Chart Update frame. Specify a 
number in the first box. Select a time period from the list in 
the right box. 
 
Select the No Automatic Update option in the Chart 
Update frame.

 
3. Select the Appearance tab and set the options as desired. Individual options on the Appearance tab are 
described in the following table. 
 



 

 

To: 
 
Display + ✤, -✤ and +2✤, -2✤ zone lines on chart 
 
Display the maximum and minimum sample values on the 
X chart 
 
Display specification limits as lines on chart 
 
Display specific markings for warnings or corrective 
actions 
 
Change the colors or line styles for the various 
components of the chart 
 
 
 
 
Change the caption of the document window that contains 
the chart 

Do this: 
 
Check Sigma Zone lines found under the Appearance tab. 
 
Check Range lines found under the Appearance tab. 
 
 
Check USL/LSL lines found under the Appearance tab.* 
 
Select a marking from the Marking Warnings or Marking 
Corrective Actions lists.  
 
Select an Item from the appropriate Screen Element list 
and click the small builder button to the right of the color 
swatch or line preview. This will invoke the standard 
Windows color picker or CRITERION line style picker, 
from which the desired color or line style may be chosen. 
 
Modify the window caption field on the Appearance tab

 
 
*Warning: Including specification limits on a control chart can be misleading, since specification limits are not 
related to statistical control. Recall that for characteristics with subgroup size greater than one, the plot-points are 
subgroup averages. Relating a plot of subgroup averages to specification limits does not truly indicate whether 
individual measurements are within specifications. 
 
4. Select the Overrides tab and set the options as desired. Individual options on the Overrides tab are described 
in the following table and in subsequent sections. 
 
To:  
 
Change the way control chart limits and centerlines are 
calculated 
 
 
Use specification limits for the chart that are different from 
those stored in the database for the characteristic 
 
Save the override specification limits to the database so 
they will be used for the characteristic from this point 
forward 
 

Do this: 
 
Manipulate the options in the Calculation Options and 
Control Limit Overrides frames as necessary. The fields in 
these frames are described in section 3.1.2.2. 
 
Select the Override Spec Limits checkbox and enter the 
appropriate values in the LSL, TGT, and USL fields. 
 
Select the Save to Database checkbox in the Specification 
Limit Overrides frame. Note that the appropriate privilege 
is required for Analysis users to change limits for 
characteristics in the database.

 
5. Click the Set Defaults button to apply the chosen view and calculation options to the default preferences. This 
will cause the specified options to be used for all new variables control charts created on the same workstation. 
 
6. Click the OK button to accept the changes or Cancel to dismiss the window. 
 
3.1.2.1 Warning & Corrective Action Options for Variable Control Charts 
 
Recall that warnings occur when out-of-control conditions are detected. When a warning is issued at the time of 
data collection, a warning code is saved with the associated subgroup of data.  Variables control charts are 
annotated using these codes and other visual cues to mark the occurrence of warnings and corrective actions. 
 
Marking Out of Control Points 
Three annotation methods are available for marking occurrences of warnings. Choose one of the methods by 
selecting from the items listed in the Marking Out of Control Points list on the Appearance tab of the Variables 
Control Chart Options window. 
 

• No Marking – Subgroups with warnings are not annotated in any way on the control chart. 
• Color Points - Points that correspond to subgroups with warnings are colored differently (usually red). 
• Warning Code - Warning codes are shown above data points that relate to subgroups with warnings. 
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• Color Points and Warning Code - Plotted points which correspond to subgroups with warnings are 
colored differently and marked with appropriate warning codes. 

 
Marking Corrective Actions 
Three annotation methods are available for marking occurrences of corrective actions. Choose one of the 
methods by selecting from the items listed in the Marking Corrective Actions list. 
 

• No Marking – Subgroups with corrective actions are not annotated in any way on the control chart. 
• Vertical Lines Both Charts - Vertical lines are drawn through both control charts to denote where 

corrective actions have occurred. 
• Corrective Action Code - Corrective action codes are displayed above plotted data points that 

correspond to subgroups with corrective actions. 
• Vertical Line and Act. Code - Vertical lines are drawn through both control charts to denote 

where corrective actions have occurred, and codes are displayed above plotted data points that correspond to 
subgroups with corrective actions. 
 
3.1.2.2 Calculation Options for Variables Control Charts 
 
Calculation options affect the method by which the centerlines and control limits are calculated for a control chart. 
Calculation defaults are initially set, however, you can change the calculation options for a specific document. As 
described below, there are four types of options that affect control chart calculations in Analysis. 
 
Selecting the control chart type 
To display a different type of control chart than is specified for use with the characteristic, select a control chart 
type from the Chart Type list on the Overrides tab of the Variables Control Chart Options window.  There are 
three types of variables control chart that are commonly used to apply SPC: The X & Moving Range chart, the X-
Bar & Range chart, and the X-Bar & Sigma chart. The X & Moving Range chart is used when a subgroup consists 
of a single measurement (i.e. subgroup size = 1). When subgroup size is one, control limits are calculated using 
moving ranges. Moving ranges are simply the differences between two consecutive subgroup (sample) values. 
When subgroups include more than one sample, the X-Bar & Range or X-Bar & Sigma charts are used. The X-
Bar & Range chart is intended for use with small subgroup sizes. For an X-Bar & Range chart, control limits are 
calculated using subgroup ranges (the difference between the largest and smallest sample values in the 
subgroup). The X-Bar & Sigma chart is intended for characteristics with larger subgroup sizes (usually greater 
than 10). For an X-Bar & Sigma chart, subgroup standard deviations are used to calculate control limits. 
 
Warning: An X-Moving R chart should only be used to monitor processes for which the data are approximately 
normal. To test normality of data, chart the data using a CRITERION Analysis histogram. The CRITERION 
Analysis histogram will not only chart the data, but actually test normality using a chi-square "goodness of fit" test. 
The table below gives further suggestions for selecting a control chart for analysis of a single characteristic. 
 
For variables data from processes where  
 
Production is slow so samples are not logically 
organized into subgroups, data approximately 
normal 
 
Samples taken from a "batch" (e.g. a chemical 
mixture), data approximately normal 
 
Logically, 1<subgroup size<11 
 
 
Logically, subgroup size > 10 

Select this chart 
 
X - Moving R 
 
 
 
X - Moving R 
 
 
X-Bar and Range 
 
 
X-Bar and Sigma 

 
Selecting a Calculation Method 
Each of the two plots in a variables control chart has a set of control limits associated with it. Control limits may be 
fixed by an administrator or calculated by the system. If fixed limits are used, they are specified for each 
characteristic in the CRITERION Admin application, and do not vary unless different limits are entered or 
calculated limits are chosen. Calculated limits are automatically re-evaluated after each subgroup using recent 
historical data. While the choice of fixed or calculated limits is specified for each characteristic by the 
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administrator, it may be overridden for the currently active control chart document. This is accomplished by 
choosing one of the four items from the Calculation Method list.  
 

• Fixed, Fixed - fixed limits are applied to both the mean and the variation charts. 
• Fixed, Calculated - control limits for the mean chart are fixed and control limits for the variation charts will 

be calculated from actual data values. 
• Calculated, Fixed - control limits for the mean are calculated and control limits for the variation charts are 

fixed. 
• Calculated, Calculated - control limits for both the mean and variation charts are calculated from actual 

data values. 
 

Warning: Calculated control limits for the X chart are derived from the same data values as those of the variation 
chart (R or S Chart). Therefore, fixing one set of control limits and calculating the other is not recommended. 
Although this practice is discouraged, to allow maximum flexibility, any combination of fixed and calculated limits 
is allowed. 
 
To save the calculation method to the characteristic record in the database, select the Save to Database 
checkbox in the Calculation Options frame. Note that the appropriate privilege is required for Analysis users to 
modify this setting in the database. 
 
Specifying Which Data to Use in the Calculations 
When control limits are calculated, recent historical subgroups are used to perform the calculations. It is important 
to understand which subgroups are used in the calculations. Two options are available.  They correspond to the 
two option buttons in Calculation Options frame of the Variables Control Chart Options window. 
 
By default, the calculated control limits are based on the most recent k subgroups in the selected data (where k is 
the number of subgroups for statistical calculations as defined for the characteristic). In this case, if 50 subgroups 
are plotted on a control chart in Analysis, and the charted characteristic is configured to use 30, then only the 30 
most recent subgroups plotted on the chart will be used to perform the calculations. Conversely, if only 20 
subgroups from that characteristic are plotted on a control chart, the control limits will still be calculated using the 
30 most recent subgroups in the database, even though all 30 are not plotted on the control chart. This setting 
corresponds to the option button labeled Calc with Characteristic Setting on the Variables Control Chart Options 
window. 
 
If desired, a control chart with calculated limits may be configured to use all of the data plotted on the chart, 
regardless of the characteristic setting. To configure the control chart to calculated control limits in this manner, 
select the option button labeled Calc with Displayed Subgroups on the Variables Control Chart Options window. 
 
Overriding or Specifying New Fixed Limits for the Chart 
When control limits are fixed, they are drawn from the characteristic record in the database. Users of the Admin 
application normally specify these limits, but Analysis users may override the limits for specific chart documents. 
In addition, Analysis users with the appropriate privilege may save the new limits to the database. 
 
Control limits are overridden with the fields in the Control Limit Overrides frame of the Variables Control Chart 
Options window. To override the existing fixed limits, select the appropriate check boxes and enter the desired 
limits in the associated text boxes. To automatically fill the text boxes with the control limit values that are 
currently stored in the characteristic record in the database, click Load Fixed button. To automatically fill the text 
boxes with the control limit values that are currently displayed on the chart, click the From Chart button. This is an 
easy way to “fix” limits that have been calculated from specific data in the Analysis control chart. Note that 
override control limits will not be used unless the chart is configured to use fixed limits rather than calculated 
limits. 
 
To save the override limits to the characteristic record in the database, select the Save to Database checkbox in 
the Control Limit Overrides frame of the Variables Control Chart Options window. Note that a specific privilege is 
required to modify characteristic limits in the database from the Analysis application. 
 
3.1.3 Viewing and Editing Data from a Variables Control Chart 
 
In addition to sample measurements, other important information is stored with variables data.  Subgroup tags, 
warnings, time and date, and corrective actions are all attached to the subgroup record. In some cases, sample 
tags are also attached to individual measurements. As described below, this information may be viewed and (with 
the required privilege) edited for any subgroup displayed on a variables control chart. 
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To view or edit data from the variables control chart 
1. On either the mean chart or the variation chart, place the mouse pointer over the plot-point that corresponds to 
the subgroup of interest. The cursor will change to a hand with an upward pointing finger. 
 
2. Click the left mouse button to display the Variables Subgroup Information window. 
 
3. If applicable, sample tags may be viewed by clicking the to the left of a sample value. 
 
4. Click the OK button to return to the control chart or click the Edit Data button to display the Variable Data Edit 
window for the selected subgroup. Instructions for editing variables data can be found in the Admin User’s 
Manual. Note that the user must have the “Edit subgroup data from charts” privilege in order to invoke the 
Variables Data Edit window. 
 
3.1.4 Masking (Excluding) a Variables Subgroup 
 
Sometimes, due to special causes or inaccurate measurements, a collected subgroup contains information that is 
unrepresentative of the actual process output. Such subgroups are typically called “outliers” because they are 
often significantly different from other subgroups taken for that characteristic. In such cases, the outlying 
subgroup can adversely affect calculated centerlines and control limits. To make calculated control limits more 
representative of the data, it may be necessary to exclude the subgroup from analysis. This is sometimes called 
“masking” a subgroup. When a subgroup is excluded, it is not deleted from the database but simply marked and 
omitted from any further statistical analysis until unmasked. Subgroups may be excluded individually or in groups. 
 
To “mask” or exclude a single subgroup from the control chart 
1. Call the Variables Subgroup Information window for the subgroup of interest by clicking on the plot point. 
 
2. Click the Edit Data button to display the Variables Data Edit window. 
 
3. Select the Excluded checkbox. 
 
4. Click the OK button to dismiss the Variables Data Edit window, then click the OK button to return to the control 
chart. The plot-point representing the subgroup will be colored gray to denote the exclusion. 
 
To “mask” or exclude multiple subgroups from the control chart 
1. Select Exclude Multiple Points from the Edit menu. 
 
2. Use the mouse to either drag boxes around or to click on the points that should be excluded. 
 
3. After you have highlighted the points that should be excluded, click the right mouse button. 
 
4. A confirmation message will be displayed which asks whether the selected points should be excluded. Click the 
Yes button to exclude the subgroups or the No button to dismiss the message without excluding any of the 
subgroups. 
 
5. The plot-points that represent the excluded subgroups will be colored gray to denote the exclusion. 
 
3.1.5 Zooming in on a Smaller Group of Data 
 
When the control chart document opens, it shows all subgroups in the selected data range. Using the zoom 
feature, the chart may be viewed with a smaller number of data points while keeping the entire set of selected 
data available. After “zooming in” a scroll bar appears along the bottom of the chart so that other subgroups in the 
selection are viewed simply by scrolling to the left or right. 
 
To “zoom in” on a smaller group of data points 
1. With the left mouse button held down, drag the pointer across the plot area to define the start and end locations 
for the smaller group of data. 
2. Release the mouse button to redraw the chart with the smaller group of data. 
 
To “undo” the zoom 
 
To return the chart back to its original state, press CTRL+Z or click Undo Zoom in the View menu. 
 
3.2 Format for Files Exported from Variables Control Charts 
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Files exported from variables control charts are all formatted in the same manner. Each line represents a single 
subgroup, and is constructed as shown below:  
 
Subgroup_number<TAB>X_bar_value<TAB>R_or_S_value<CR/LF> 
 
Points that are excluded (masked) in the control chart will not be included in the export file. The subgroup 
numbers that are included as the first field of each line are arbitrary, due to the fact that CRITERION does not 
sequentially number the subgroups in the database. The arbitrary numbers will always start with 1, and will 
increment by 1 in each subsequent line. In files exported from x-bar and moving range charts, X-bar is replaced 
by the x value, and R is replaced by the moving range. 
 
3.3 HISTOGRAMS 
A histogram is a bar chart that is used to make estimates and to form assumptions regarding a set of data values. 
Each bar of the histogram represents a small portion of the overall range of data values, and counts the frequency 
of samples that fall within that portion. When viewed as a whole, the bars of the histogram provide a rough visual 
representation of the overall distribution of the sampled data values. Using statistical methods, the distribution of 
the population is estimated from the sample, and superimposed on the bar chart as a continuous curve. Together, 
the actual sample distribution and estimated population distribution can be used to estimate a number of other 
important statistics.  Histograms created with the CRITERION Analysis application document display descriptive 
statistics in the same window with the histogram chart. 
 
Many of the values calculated for the histogram rely on the assumption that the process distribution is normal. To 
ensure that this is the case, the Analysis application tests data before creating the histogram. If normality of the 
selected data is questionable, the user is prompted to choose between normal and non-normal (Johnson) 
statistics before the chart is created. If non-normal statistics are chosen, the data is transformed according to the 
appropriate Johnson transformation. Johnson transformations provide systematic methods for relating a set of 
non-normal data to one that is approximately normal. After the data is transformed, many of the statistics (i.e. the 
capability indices) reported for normal data may be reported for non-normal data. 
 
3.3.1 Creating a Histogram 
 
To create a histogram for a variables characteristic, follow the instructions listed below: 
1. Select New from the File menu. 
 
2. In the Chart Selection window, select Histogram. 
 
3. From the product tree, select the characteristic to be used by highlighting it, and then clicking the Add button. 
 
4. Proceed with data selection. 
 
5. After selecting the data, specify whether or not the Johnson transformation should be utilized. 
 
3.3.2 Customizing Histogram Charts 
 
A histogram in the Analysis application is customized by changing options for the associated document.  Once 
created, however, the document options can be changed without affecting the default preferences. If the 
document is saved as a file, the customized options are saved in the file and applied whenever the document is 
re-opened. The options available for customization of histograms are divided into those that affect the document's 
appearance (view options), and those that affect the chart's underlying calculations (calculation options). 
To set options for the active histogram document 
1. Select Options… from the Chart/Report menu. This calls the histogram options window. This window has two 
tabs for view options (labeled View and Appearance) and another for options specific to the calculated statistics.  
2. Set options on the View and Appearance tabs as described in section 3.3.2.1. 
 
3. Set options on the Statistics tab as described in section 0 
 
4. If desired, click the Set Defaults button to apply the chosen options as default preferences. This will cause the 
specified options to be used for any new histograms created on the same workstation. 
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5. Click the OK button to accept the changes or Cancel to dismiss the window. 
 
3.4 View Options for Histograms 
 
The controls and fields on the View and Appearance tabs of the Histogram Options window are described below. 
 
To: 
Display specification limits, target, sample mean, or sigma 
lines as vertical lines on the chart. 
 
Display horizontal grid lines on the chart. 
 
Display the distribution curve 
 
Display the subgroup tag values used to filter the selected 
data 
 
Display the chart type (i.e. Normal Histogram) 
 
Define a label for the X-axis 
 
Change the labels for the primary and secondary process 
capability indices 
 
 
 
 
 
 
Display a header or footer 
 
 
Automatically update the chart 
 
 
 
Disallow auto updating of the chart 
 
 
Change the colors or line styles for the various 
components of the chart 
 
 
 
 
 
Change the caption of the document window that contains 
the chart 
 
Over-ride the characteristic’s target and specification limits 
with specific values 
 
 
 
 

Do this: 
Check USL/LSL Line, TGT Line, Mean Line, or +/-Sigma 
Line on the View tab. 
 
Check Grid Lines on the View tab. 
 
Check Show Curve on the View tab. 
 
Check Data Tags on the View tab. 
 
 
Check Chart Type on the View tab. 
 
Enter text in the X-Axis Label box on the View tab. 
 
Select pre-defined labels from the Primary Potential, 
Primary Actual, Secondary Potential, and Secondary 
Actual lists on the View tab, or type your own labels. 
Potential capability indices are usually named with two-
letter acronyms like "Cp" and "Cm".  Indices of actual 
capability are usually named with three-letter acronyms 
like "Cpk" or "Cmk". 
 
Enter text in the Header Text or Footer Text boxes on the 
View tab 
 
Select the first option in the Chart Update frame on the 
View tab.  Specify a number in the first box.  Select a time 
period from the list in the right box. 
 
Select the No Automatic Update option in the Chart 
Update frame on the View tab. 
 
Select an Item from the appropriate Screen Element list on 
the Appearance tab, and click the small builder button to 
the right of the color swatch or line preview. This will 
invoke the standard Windows color picker or CRITERION 
line style picker, from which the desired color or line style 
may be chosen. 
 
Modify the window caption field on the Appearance tab. 
 
 
On the Appearance tab, select the Override Spec Limits 
checkbox and fill in the Lower Spec Limit, Target, and 
Upper Spec Limit fields with the appropriate values. Note 
that the override specification limits are only applied to this 
chart document, and are not saved to the database nor 
used for any other analyses.

 
 
3.5 PROCESS CAPABILITY SUMMARY CHARTS 
 
In order to understand Process Capability Summary Charts, one must first have a working knowledge of Process 
Capability and what this means to SPC. Process Capability is a measure of the ability of the process to produce 
acceptable products. Of course, products that are controlled with variables characteristics are acceptable only 
when the measured values of the characteristics fall within the ranges of the specification limits. Thus, process 
capability is quantified by comparing the specification range with the estimated spread of the process.  
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Traditionally, the spread of the process refers to an interval centered on the mean with a length of six standard 
deviation units (six-sigma). Almost all measured values will fall within this interval. The ratio of the size of the 
specification range to the size of the six-sigma spread measures the potential capability of the process, and is 
often denoted Cp. The Cp index is only a measure of potential capability because it takes no account of the 
location, or central tendency of the process. It gives the actual capability that would be realized if the distribution 
were perfectly centered on the target specification. Another process capability index (often called Cpk) includes 
information about the location, or central tendency of the process distribution. Consequently, even if the process 
variation is relatively small, the Cpk can indicate low process capability due to an improperly centered process. 
 
A process capability chart is a report that shows the ability of a process to generate products that meet 
specifications. This report is represented as a proportion of specification (tolerance) spread to actual process 
spread. In many cases, SPC administrators have so many processes to control, that the amount of information 
produced by the various analysis methods can be overwhelming. In such cases, it is important to have some form 
of summary report that quantifies the quality level of a number of processes. Such a report can help to identify 
those processes that require the most attention. 
 
Information listed on a Process Capability Chart 
 
The process capability chart provides both graphical and textual analysis of the capability of multiple 
characteristics. A row in the chart is displayed for each characteristic. Each row lists the name of the 
characteristic along with various other information that is either retrieved from the database or calculated from the 
data. This includes a graphical box-plot that shows the location and spread of the selected data in relation to the 
specification limits. The spread shown by the box plot is usually -3 to +3 sigma, but can be changed by setting the 
desired sigma level in the chart options. Two vertical lines span all of the box plots and represent the upper and 
lower specification limits. The box plot for each feature is centered at the mean value and extends n standard 
deviation units (where n is the desired sigma level), indicating the spread of the process distribution. If this spread 
extends beyond one of the specification limits, it is colored solid red; otherwise, it is outlined in green. The mean 
is indicated by a small vertical line that halves the spread, and a red carat indicates the relative location 
of the last recorded sample value. 
 
For each characteristic, various other calculated statistics are displayed as configured in the chart options. The 
calculated statistics are a subset of those available for histograms. 
 
3.5.1 Creating a Process Capability Chart 
 
To create a Process Capability Chart for one or more variables characteristics, follow the instructions listed below 
 
To create a Process Capability Chart 
 
1. Select New from the File menu. 
 
2. In the Chart Selection window, select Process Capability. 
 
3. Display the product tree by selecting the option button labeled Product on the left side of the window. 
 
4. From the tree, select the characteristic(s) to be used for the chart by highlighting the appropriate item and 
clicking the Add button or by double-clicking on the name of the characteristic. 
 
5. Proceed with data selection. Note that the Data Selection window for Process Capability charts is different from 
that for single-characteristic charts like histograms. It allows you to specify different data tag criteria for each 
selected characteristic. This is accomplished by highlighting one or more of the characteristics in the list provided 
prior to selecting or de-selecting tags. 
 
3.5.2 Customizing Process Capability Charts 
 
The appearance and behavior of a Process Capability chart may be customized by changing the options for the 
associated chart document. Recall that new analysis documents assume the options that were previously defined 
as defaults. Once created, however, the document options can be changed without affecting the default 
preferences. If the document is saved as a file, the customized options are saved in the file and applied whenever 
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the document is re-opened. The options available for customization of Process Capability charts are a subset of 
those available for histograms.  
 
3.6 STATISTICS OF SAMPLES REPORTS 
 
Statistics of Samples reports (SOS) are used to generate detailed summaries of sample data. This report is 
extremely useful if you are manufacturing the same product on more than one process at the same time, and 
different samples in a subgroup are used to represent different dies, cavities, or machine stations. Common 
products produced with parallel processes include injection molding, stamping, and die cutting.  The SOS reports 
provide users with specific sample data on multiple characteristics for one product at a time. This report will 
accommodate up to 9 samples per subgroup. For each characteristic, the report lists specification limits, target 
values, actual sample values, and calculated statistics. Each sample outside of the characteristic’s specification 
limits will be shown in RED. A "+" or "-" sign is listed after the number indicating whether the sample was above 
the USL or below the LSL. The report also includes summary statistics for complete subgroups and for each 
sample position (Sample 1, Sample 2, etc.). The user may customize SOS reports to only display necessary 
information. 
 
3.6.1 Creating a Statistics of Samples Report 
 
1. Select New from the File menu. 
 
2. In the Chart Selection window, select Statistics of Samples. 
 
3. From the product tree, select one or more characteristics from the same product by highlighting the name in the 
tree and clicking the Add button. You cannot select characteristics from different products. 
 
4. Click the OK button and proceed with data selection. SOS reports may be filtered based on subgroup tag 
values, but only one set of filter criteria may be used for the entire report. It is not possible to specify different filter 
criteria for each of the selected characteristics. 
 
3.6.2 Customizing Statistics of Samples Reports 
 
A Statistics of Sample (SOS) Report in the CRITERION Analysis application may be customized by changing 
options for the associated document. Recall that new analysis documents assume the options that were 
previously defined as defaults. Once created, however, the document options can be changed without affecting 
the default preferences. If the document is saved as a file, the customized options are saved in the file and 
applied whenever the document is re-opened. 
 
To set options for the active Statistics of Sample Report 
 
1. Select Options… from the Chart/Report menu. The Statistics of Samples Reports Options window will appear. 
 
2. Modify the options as necessary. Options for Statistics of Samples reports are similar to those for other types of 
charts and reports in the CRITERION Analysis application. 
 
3. Click the OK button to accept the changes or click the Cancel button to dismiss the options window without 
making any changes. 
 

4. PREFERENCES AND DEFAULTS 
 
Analysis preferences affect the appearance and functionality of the application and provide a way to specify the 
location of CRITERION databases. Defaults set in preferences affect only the Analysis application at the 
computer on which they are defined. Any user with administrative privileges in the Analysis application may set 
preferences as directed below.  
The preferences for the Analysis application are divided into three categories: defaults for the application in 
general, defaults for specific analysis charts, and the selection of database files. The sections below describe 
each of these in greater detail. 
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4.1 DEFINING GENERAL ANALYSIS PREFERENCES 
 
Some Analysis preferences apply to the application in general. 
 
To set general preferences 
 
1. Select Preferences from the File Menu. 
 
2. Select Analysis Defaults from the resulting sub-menu. 
 
3. Set prefixes for default document filenames by selecting a chart type from the list box and specifying a prefix in 
the associated text box. These will be used to build default chart filenames when the Save As window is invoked. 
 
4. If desired, select the checkbox labeled Display Start and End Times for Data. This determines whether time 
ranges are shown for each characteristic in the System Viewer window. 
 
5. If you wish for backup files to be made when saving documents, select the Backup files during save checkbox. 
 
6. If you wish to display the list of recently used files in the file menu, select the corresponding checkbox and 
specify the number of entries to include. 
 
7. Select one of the options in the frame labeled Path to display on status line. 
 
8. Specify a method for sorting the items in the Product and Process trees. 
 
9. If desired, enter the path and filename of a program and the path of the program’s working directory in the 
appropriate text boxes. This will enable the user to launch the specified program using a button on the toolbar. 
The path and filename of the program may be selected by browsing (click the builder button to do so), but the 
path of the working directory must be typed in. 
 
10. Click the OK button to dismiss the Preferences window and save changes, or click the Cancel button to 
dismiss the window without saving any changes. 
 
4.2 DEFINING PREFERENCES FOR SPECIFIC ANALYSIS TYPES 
 
The CRITERION Analysis application offers different view and calculation options for each type of analysis chart. 
By setting preferences for an analysis type once, you define the look and function of new document of that type. 
 
To set preferences for a specific type of Analysis document 
 
1. Select Preferences… from the File menu. 
 
2. Select Chart Defaults from the menu that appears. 
 
3. Select the desired analysis type by clicking the picture button in the chart selection window. 
 
4. Configure the options as desired. Available options vary among analysis types. Details about the options for 
each specific type of analysis are given in the sections for that particular chart. 
 
Note that the defaults for some options are drawn from the characteristics record in the database.  These items 
will be disabled when setting defaults as preferences. 
 
5. Click the OK button to save the default options, or click the Cancel button to dismiss the window without 
changing the defaults. 
 
Note that it is also possible to set the default options while setting options for a specific document. To do this, 
simply select the Set Default checkbox on the chart options window prior to clicking the OK button. This will set 
default options as well as the options for the current chart. 
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